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Introduction 
The Pictometry® for ArcGIS Pro – Connect add-in integrates Pictometry imagery into ESRI’s ArcGIS 
Pro product. 

After you install the Pictometry add-in in ArcGIS Pro, a Pictometry tab appears on the ribbon. The 
Pictometry tab gives you access to Pictometry tools and features, including tools that let you 
analyze images (available while logged in).  

To view Pictometry imagery, you’ll click the Pictometry Select Location button (in the Pictometry 
tab of the ribbon) and then click a point in the ArcGIS Pro Data Frame. Once you’ve logged in, the 
add-in opens a Pictometry image for the location you clicked. 

Installing the add-in 
This topic describes the tasks required to install the Pictometry for ArcGIS Pro - Connect add-in 
version 1.0.0 in ArcGIS Pro Version 2.0-2.7.2. You’ll install it just as you would any other ArcGIS Pro 
add-in. The Pictometry add-in is called “Pictometry for ArcGIS Pro - Connect.esriAddinX”. 

To install the add-in: 
1. Make sure that ArcGIS Pro is closed.

If you don’t already have the link to the Pictometry Software Downloads website from
which you can download the add-in, please contact your EagleView Sales
Representative for it.

2. Download and save the Pictometry ArcGIS Pro add-in from the Pictometry Software
Downloads website.

3. Double-click the Pictometry for ArcGIS Pro - Connect.esriAddinX file. The ESRI ArcGIS
Add-In Installation Utility opens and displays the following dialog box.

PGAUTA-BLRM21
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4. Click Install Add-In. The add-in is installed and a dialog box confirms if the installation
was successful.

After installation 
Once installed in ArcGIS Pro, the Pictometry add-in is loaded automatically when you open ArcGIS 
Pro. In order to see the Pictometry tab (on the ArcGIS Pro ribbon), you must have a map open. 

Figure 1: The Pictometry Add-in after installation. 

The Pictometry tab 
The Pictometry tab contains various buttons for using the add-in’s features. 

Figure 2: The Pictometry tab. 

Pictometry tab 

A group 
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Note: Some groups (like Measurements) are not available until you search for and display an 
image. However, the Select Location, Settings, Help, and Feedback buttons are always enabled. 

The “Pan” button in the Measurements group has a pull-down menu that contains a button for 
each measurement tool. 

Figure 3: Measurement tools. 

The Pictometry tab contains the following buttons. 

Tool Description 

Select Location Searches for images containing the geographic point you clicked in the ArcGIS 
Pro Data Frame. 

Note: If the Select Location tool is active, you can pan the ArcGIS Pro 
map by dragging the map. You don’t need to select ArcGIS Pro’s Pan 
tool first. 

Search Address Lets you search for an image that shows the street address you enter. 

Identify Lets you identify all GIS layers within a region by drawing a rectangle around 
that region in the image. 

Pan Scrolls the image around in the Image Viewer window. 

Distance Measures the distance between two points in an image or the cumulative 
distance along a series of straight-line segments. 
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Tool Description 

Height Measures the height of a building or an object in an oblique image, starting 
from the ground. 

Area Calculates the area of any part of an image. 

Elevation Gives the elevation above sea level of a location in an image. 

Location Lets you view the coordinates of a location in an image. 

Bearing Measures the bearing (the orientation from True North) of an angle you 
outline in the active image.  

Clear Removes all measurement annotations from the Image Viewer window. 

Extract Lets you select a portion of the image in the Image Viewer window and export 
it to a JPG file. The extracted image is saved to the file with the options you 
specified on the Pictometry for ArcGIS Pro Settings dialog box.  

Save Orthogonal 
Image 

Lets you save an orthogonal image as a GeoTIFF file. 

Settings Opens the Pictometry for ArcGIS Pro Settings dialog box so you can change the 
add-in’s settings (such as units of measure). 

Help Opens this user guide locally on your computer. 

Feedback Opens a feedback form. Use this form to provide feedback about the add-in 
when you do not need a response or technical support. 
If you need technical support, please follow the normal customer support 
process so that we can handle your questions or problems as quickly as 
possible. 

Logout Logs you out of the Pictometry for ArcGIS Pro - Connect add-in. 
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Logging in 
Before you can view any images, you’ll need to log in to the add-in with the credentials for your 
CONNECT account. The Login page appears in the Image Viewer window after you click the Select 
Location button on the Pictometry tab and click a location in ArcGIS Pro. 

Figure 4: The Login page. 

The first time you log in to the Pictometry add-in, a software license agreement opens. Click I 
Accept to agree to the license terms and open the Image Viewer window. 

If you need to change your password at any point, use the following procedure. 
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To change your password: 
1. Click Change Password. The Login page now displays fields for you to enter your

current and new passwords.

2. Enter the email address you use to log in and your old password. Then enter a new
password twice and click Change.

The Image Viewer window 
The Pictometry Image Viewer window opens only after you click the Select Location button and 
click a point on your ArcGIS Pro map. After you log in, images are displayed in the Image Viewer 
window. 

Figure 5: The Image Viewer window. 

The Image Viewer window can be resized, moved, docked, undocked, or closed, just as with any 
other window in ArcGIS Pro. On-image navigation controls allow you to change image zoom or 
view different images or map types. (These features are discussed later in this guide.) 

Image Viewer window 

Layers list 

Zoom bar 

Compass 

Navigation button 
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To move the Image Viewer window: 
1. With the mouse pointer, grab the title bar of the Image Viewer window and drag it to

another spot on the screen.

Tip: When near another docked part of the screen, the window will automatically 
try to attach (dock) to the other area. To prevent the window from docking, hold 
down the CTRL key until you decide where to locate the window. 

2. Release the mouse button. If you’re trying to dock the window, release the CTRL key.
(The window will not dock as long as CTRL is held down.) If it’s not near a docked area,
the window floats on the ArcGIS Pro application.

To close the Image Viewer window: 
 Click its Close button (X).

Viewing images 
To view images in the Image Viewer window, click the Select Location button (on the Pictometry 
tab) and then click a location in your map. The Image Viewer window shows the best north-up 
image for the location you clicked. (If there are no north-up images, then the best available image 
is displayed.)  

If overlays are enabled (on the Settings dialog box), the image displays any line, point, and polygon 
layers currently displayed on your ArcGIS Pro map. 

The image polygons and current location marker 
Depending on your display settings, the following polygons might appear on the ArcGIS Pro map 
when you open an image in the Image Viewer window: 

 view-region polygon (footprint of the area currently visible in the Image Viewer window)

 image polygon (footprint of the entire image)

These polygons help you stay oriented between the image in the Image Viewer window and the 
map in the Data Frame. 

Tip: To change your user settings, click the Settings button on the Pictometry tab. 

The add-in also displays a current location marker in the Data Frame. The current location marker 
indicates the location you are currently viewing in the Image Viewer window. If you click a new 
location in the image (or use the Select Location button to navigate to a different location), the 
add-in updates the current location marker on the map. 
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The following map shows an image polygon, view-region polygon, and current location marker. 

Figure 6: Image polygon, current location marker, and view-region polygon in the Data Frame. 

Synchronization 
By default, the image and the ArcGIS Pro map are not synchronized. However, if synchronization is 
turned on (in Settings), then when you click a new location in the image or navigate to a different 
location, the add-in moves the current map to the same location, so the image and map stay 
synchronized. (You can turn on synchronization or change how the image and map are 
synchronized on the Settings dialog box. See page 17 for more options.) 

Viewing a different image of the same area 
If more than one image of the same (or similar) orientation is available for the current location, you 
can view those other images. The Pictometry add-in keeps a list of available images. The Image 
Viewer window shows how many images are in the list, as well as which of the images you’re 
currently viewing. (For example, “1 of 44” means the first image of 44 is currently displayed.) 

To view a different image of the same area: 
 Use the Previous image and Next image buttons.

A different image of the same location, taken from the same direction opens. 

Next image Previous image 

view–
region 

polygon 

image 
polygon 

current 
location 
marker 
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Note: At the end of the list, the Next image button retrieves the first image in the list. At the 
beginning of the list, the Previous image button returns the last image in the list. 

Viewing from a different direction 
While viewing an image, you can easily view the current scene from a different direction. 
Navigation buttons (semi-transparent buttons at the edges of the image) let you view the location 
from the north, east, south, west, or from straight down (orthogonally). 

Figure 7: Navigation buttons. 

Click the Navigation button that corresponds to the desired orientation. 

Hint: Move the mouse over a Navigation button to see what image orientation will be 
displayed when you click that button. For example, if you want to see the current location from 
the south, find the navigation button that displays "View From South" when you move the 
mouse over it. 

An image of the desired orientation opens in the Image Viewer window. 

Zooming in and out 
Zooming in and out allows you to view images taken at different altitudes (shot levels). For 
example, Neighborhood images are taken from a lower altitude, allowing you to focus in on details, 
such as fire hydrants or building heights. Community images—shot at a higher altitude to show 
more geographic area—are helpful for locating and navigating to points of interest. 

You’ll use the Zoom bar to zoom in or out. 

To zoom in or out: 

Do either of the following: 

 To change the zoom incrementally, either drag the Zoom bar’s slider, or click the Zoom
bar’s minus sign (-) to zoom out and its plus sign (+) to zoom in.

 To jump directly to a zoom level, move the mouse to the right of the Zoom bar until
the Zoom Shortcuts (icons) appear. Click the icon for the level you want to zoom to.

Panning images 
The Pan tool lets you see a different part of an image by dragging your mouse. When you pan to 
the edge of an image, the application automatically displays the next adjacent image. 

If the “synchronize map and image to each other” option is selected (on the Display tab of the 
Settings dialog box), the map and the Pictometry image automatically stay synchronized on the 
same geographic area when you pan. 
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To pan the image: 
1. On the Pictometry tab, click Pan (if the tool is not already active).
2. Drag the image in the desired direction, and then release the mouse button.

Panning while a tool is active 

You can easily pan the current image while a measurement tool is active by simply holding down 
the left mouse button and dragging the image. When you release the mouse button, the tool that 
was active before you panned is still selected, so you can continue to use that tool without having 
to click it again. 

Searching for images by street address 
You can search for images by a street address in a specific city by entering the address, city, state, 
and zip code as search criteria. But you can also search more generally for that address to find it in 
multiple cities by leaving the city, state, or zip code out of the search criteria you enter. 
Alternatively, you can enter lat/long coordinates to search for images that show that location. 

To search by street address: 
1. On the Pictometry tab, click Search Address. The Search dialog box opens.

2. Type the search criteria (the partial or complete street address).
3. Click Search.

What happens next 

If … This happens … 

The address is found The Image Viewer window displays an image that shows the location of 
the address you typed. 

The application cannot 
find an image that 
shows that address.  

No image appears. The address might be outside the area for which you 
have image coverage. 

You entered a partial 
address 

The Image Viewer window displays the center of the geographic area in 
which that address is located. For example, if you entered a zip code only, 
you'll see the center of the geographic area that has that zip code. 
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Tips for better search results 

You might get better results when searching if you use more commas between the parts of the 
address than you would normally use. 

For example: 

Instead of “Apt. B 123 Main Street, Anywhere, NY” 
Enter this “Apt. B, 123, Main Street, Anywhere, NY” 

Searching by coordinates 

To search by coordinates: 
1. On the Pictometry tab, click Search Address. The Search dialog box opens.
2. Type the lat long coordinates of the location you wish to search for. (See the following

guidelines.)
3. Click Search.

Guidelines for entering coordinates: 

 Enter the latitude and longitude as degrees. Example: 43.067112,-77.643156

 Enter a comma between latitude and longitude. Do not use a slash (/).

 Do not use the symbol for seconds (') or the symbol for minutes (").

 Enter only one space between degrees minutes and seconds. (More than one space is
considered invalid.)

Viewing GIS layers on your imagery 
You can view GIS layers on your imagery by selecting them from the Layers list. If you have layers 
visible in the ArcGIS Pro map, you can also view those layers on your images. 

To view Pictometry GIS layers: 

1. Click the Layers button  in the Image Viewer window. 
2. Select the check boxes for the layers you wish to view.

To view layers shown on the ArcGIS Pro map: 
1. On the Pictometry tab, click Settings.
2. On the Settings dialog box, click the Display tab.
3. In the “Vector overlays on Image” section, select or clear the buttons and check boxes,

as desired.
− To overlay all visible elements, select Overlay all Elements.
− To overlay only selected elements, select Overlay Selected Elements. Then use the

ArcGIS Pro Selection tool to highlight the elements on the map. Those elements
will be drawn on Pictometry images.

The overlays are drawn in the same color as the layer in the map. 



Using measurement tools 

Pictometry for ArcGIS Pro - Connect Add-in Guide 2.0-2.7.2 12 

Using measurement tools 
The Pictometry add-in offers various tools for measuring what you see in an image. For example, 
you can measure the distance between two points, the elevation of the terrain, building heights, 
bearing, area, perimeter, and the coordinates of a point. After measuring, you’ll see the 
measurements on the image in the Image Viewer window.  

Before using the measurement tools, be sure that the unit of measure is set as desired. 

Changing units of measure 

To change units of measure: 
1. On the Pictometry tab, click Settings. The Pictometry for ArcGIS Pro Settings dialog box

opens.
2. Click the desired units: Meters or Feet.

Your changes remain in effect until you change units again.

Measuring distance and perimeter 
You’ll use the Distance tool to measure the distance between two or more points in one or more 
images, and to measure perimeter—the distance around the outside edge of any object. 

To measure distance or perimeter: 
1. On the Pictometry tab, in the Measurements group, click the down arrow, and then

click Distance.
2. Click the point at which to start measuring.
3. (Optional) Click multiple points to measure multiple segments.
4. Double-click where you want to stop measuring.

Measuring height 
The Height tool lets you measure the height of an object in an oblique image. (Because orthogonal 
images are captured straight down, the Height tool does not apply to them.)  

To measure height: 
1. On the Pictometry tab, in the Measurements group, click the down arrow, and then

click Height.
2. To measure from the ground up, click the ground point of the object to be measured.

To measure from the top down, click the top point of the object to be measured.
3. Double-click where you want to stop measuring.

Measuring area 
The Area tool lets you measure the area of any shape, whether it has curved or straight sides. 

To measure the area of a shape: 
1. On the Pictometry tab, in the Measurements group, click the down arrow, and then

click Area.
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2. Click the desired starting point.
3. Outline the shape to be measured, by clicking points on its perimeter.
4. When you’ve outlined the entire shape, double-click to end the measurement.

Measuring elevation 
Use the Elevation tool to measure the elevation (height above sea level) of a location in an image. 

To measure the elevation: 
1. On the Pictometry tab, in the Measurements group, click the down arrow, and then

click Elevation.
2. Click the point whose elevation you want to measure.

Viewing the coordinates of a location 
Use the Location tool to view the coordinates of a location in an image or map. 

To view a location's coordinates: 
1. On the Pictometry tab, in the Measurements group, click the down arrow, and then

click Location.
2. Click the desired location in the image.

The current location marker moves to the new location on your map.

Note: For oblique images, click nearby the base of buildings for more accurate 
coordinates. 

Measuring bearing and angles 
Use the Bearing tool to measure the bearing of a line or the angle formed by the intersection of 
two lines in an image. How you draw the line is important, as shown in the following illustrations: 
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To measure bearing: 
1. On the Pictometry tab, in the Measurements group, click the down arrow, and then

click Bearing.
2. Click the starting point.
3. Double-click the ending point.

To measure an angle: 
1. On the Pictometry tab, in the Measurements group, click the down arrow, and then

click Bearing.
2. Click the starting point (the vertex of the angle).

3. Double-click the end point of the second ray of the angle.

Extracting images 
To export only a portion of the (oblique or orthogonal) image shown in the Image Viewer window, 
you'll draw a rectangle around that part of the image with the Extract tool. The rectangle defines 
the part of the image to be extracted. The file is generated in the format currently selected on the 
Options tab of the Settings dialog box. 

Before extracting 
Before you extract an image, set up image-extraction defaults on the Pictometry for ArcGIS Pro 
Settings dialog box. 

To set up extraction defaults: 
1. On the Pictometry tab, click Settings.
2. On the Settings dialog box, click the Options tab.
3. Select a default file format from the File type list.
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4. (Optional) Select or clear the checkboxes for removing the compass, overlays, and shot
date, as desired.

Extracting an image 

To extract a portion of an image: 
1. On the Pictometry tab, click Extract.
2. Click one corner of the rectangle that will define the region to be extracted.
3. Click the corner that is diagonally opposite to the first corner.
4. Save the file to your hard drive and note the name of the folder to which the file was

saved. (Your browser might automatically save the file to the "Desktop" folder, or it
might allow you to navigate and choose the folder to download the file to.)

Saving orthogonal images 
If you’re viewing an orthogonal image, you can use the Save Orthogonal Image button on the 
Pictometry tab to save the entire orthogonal image shown in the Image Viewer window as a 
GeoTIFF file. (This option applies only to orthogonal images and always saves the image in GeoTIFF 
format.) 

Identifying GIS layers 
If you have access to GIS data for your imagery, you can identify all GIS layers within a region by 
drawing a rectangle around that region in the image. All GIS objects within or touching the 
boundary of that region are outlined and shaded in color. 

Note: To identify GIS layers, you must have access to GIS data for your imagery. 

To identify GIS data within the Pictometry add-in: 
1. On the Pictometry tab, click Identify.
2. In your image, click one corner of the rectangle that will define the region to be

identified.
3. Click the corner that is diagonally opposite to the first corner.

The Identify Results window (or windows) appears and displays the data.

Why do I see two Identify Results windows? 
If Pictometry street or parcel layers are turned on (in the Image Viewer window’s Layers list), those 
layers can be identified, in addition to any layers in the ArcGIS Pro Data Frame. Results from 
Pictometry layer data appear in a separate Identify Results window from that of ArcGIS layer data. 
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Add-in settings 
The Pictometry add-in has various properties that affect searching for and viewing images. Clicking 
the Settings button in the Pictometry tab opens the Pictometry for ArcGIS Pro Settings dialog box, 
on which you can set options such as units of measure. 

Note: The settings are updated when you click Ok. There is no need to restart ArcGIS Pro. 

The Pictometry for ArcGIS Pro Settings dialog box 

Display tab 

You’ll use the Display tab the Pictometry for ArcGIS Pro Settings dialog box to set up various 
options that affect how images are displayed and how labels appear in your ArcGIS Pro Data 
Frame. 

Figure 8: Display tab. 
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The Display tab contains the following options. 

In this field … Do this … 

Display 
Navigation 
Controls on 
Image 

Select this option if you want navigation controls (Zoom bar, Compass, Map 
Type list, etc.) displayed in the upper left corner of the Image Viewer window. 
(The navigation controls are shown in Figure 5 on page 6.) 

Display Image 
Footprint on 
Map 

Select this option if you want an image polygon to be shown on the map. The 
image polygon represents the footprint of the entire image, not just the 
portion shown in the Image Viewer window. 

Display Location 
on Map 

Select this option if you want the current location marker to be shown on the 
map. 

Display View 
Region 

Select this option if you want a view-region polygon to be shown on the map. 
The view-region polygon represents the part of the image that is currently 
visible in the Image Viewer window. 

Synchronization Select one of these options for synchronizing the map and Pictometry image. 
• None - No synchronization — Does not synchronize the workspace

and the image to each other when one is moved or panned.
• Rotate Map to Image Footprint — Automatically rotates the map to

match the orientation of the image in the Image Viewer window. For
example, if your image is south-up (taken from the north), selecting
this checkbox causes the add-in to rotate the map so it is south-up.

• Zoom Map to Image Footprint — Automatically magnifies the map to
show the area within the Pictometry image footprint (image polygon).

• Synchronize Image to Current Map Location — Automatically
synchronizes the Pictometry image to match the center of the map as
the map is moved.

• Synchronize Map to Current Image — Automatically synchronizes the
center of the map to match the center of the Pictometry image, as the
image is panned.

• Synchronize Map and Image to one another — Causes the map and
the Pictometry image to automatically stay synchronized on the same
geographic area when you pan either one.

Vector overlays 
on Image 

Select how you want vector overlays displayed on Pictometry images. 
If you choose to display overlays, the vectors are drawn in the same color as 
the layer in the map. To overlay selected elements, use the ArcGIS Pro 
Selection tool to highlight the elements on the map. Those elements will be 
drawn on the Pictometry images as well. 
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In this field … Do this … 

Ignore features 
containing 
more than 
<XXX> points

Very large polygons can take a long time to draw on the Pictometry image. 
This option allows you to ignore very large polygons when displaying overlays 
on Pictometry images. The value can be anywhere from 10 points to 10,000 
points, with a default value of 1,000.  

Options tab 

You’ll use the Options tab to set the units of measure in which measurements are shown, extract 
image options used by the Extract tool, and options for displaying Pictometry layers on images. 

Figure 9: Options tab. 

The Options tab contains the following options. 

In this field … Do this … 

File Type Select the format in which to save the extracted image. 

Remove 
Compass 

Select this option if you do not want a compass overlaid on the extracted image. 

Remove 
Overlays 

Select this option if you do not want overlays on the extracted image. 
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In this field … Do this … 

Remove 
ShotDate 

Select this option if you do not want the shot date overlaid on the extracted 
image. 

Units Select the unit of measure in which measurements should be displayed. 

Display 
Contour Lines 

Select this option to view contour lines on your images. You can also change the 
distance between major contour lines and between minor contour lines, if 
desired. 

Update Checker tab 

You’ll use the Update Checker tab if you want to turn on or off automatic checking for updates. (By 
default, the add-in checks for updates every time it’s started.) You can also check for updates at 
any time while the add-in is open by clicking Check for updates now on this tab. 

Figure 10: Update Checker tab. 

Sending feedback 
To provide feedback about the Connect add-in, click Feedback (on the Pictometry tab) and 
complete the feedback form. Use this form to provide feedback when you do not need a response 
or technical support. 
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If you need technical support, please follow the normal customer support process so that we can 
handle your questions or problems as quickly as possible. Thank you! 

Troubleshooting 
Problem Explanation 

No image appears in the 
Image Viewer window 

You clicked the Select Location button and clicked your map in 
the ESRI Data Frame, but no image appears in the Image Viewer 
window. 
You might not have available images for the area you clicked. 
-or-
You might have clicked the map outside of the region covered by 
your images. 

Updating ArcGIS Pro 
If you install a newer version of ArcGIS Pro, you should download and install the latest Pictometry 
add-in. 

Updating the Pictometry add-in 
By default, the Update Checker is turned on so the Pictometry add-in automatically checks for 
updates at startup. (See “Update Checker tab” on page 19.) 

Note: If you want to turn the Update Checker off, click the Settings button on the Pictometry 
tab and clear the Always check for updates on startup check box on the Update Checker tab. 

If any updates are found, a dialog box opens and provides a link to download the new version. To 
update the add-in immediately, click the link in the dialog box. (See the following procedure.) 

To update the add-in immediately: 
1. Click the link in the “New Version Available” dialog box. The Pictometry Software

Downloads page opens in a browser window.
2. From the list of software titles, select the name of the software you want to update.
3. In the Application column, click the link that corresponds to the version you want to

download.
4. Save the file to your hard drive and note the name of the folder to which the file was

saved. (Your browser might automatically save the file to the "Desktop" folder, or it
might allow you to navigate and choose the folder to download the file to.)

5. When the download is complete, close any open download dialog boxes.
6. Exit the software if you want to install the update right away.
7. Install the new add-in as you would for any other ArcGIS Pro add-in. See page 1 for

more information.
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Removing an older version of the add-in 
The following procedure for removing an older version of the Pictometry add-in applies only if you 
installed it manually by using the “Pictometry for ArcGIS Pro – Connect.esriAddinX” file. (If you 
installed the add-in automatically from a folder, it appears under the “Options” section of the Add-
In Manager dialog box and the “Delete this Add-In” button will not be available.) 

To remove an older version of the add-in: 
1. In ArcGIS Pro, on the Project tab, click Add-In Manager.

2. On the Add-Ins tab, select Pictometry® for ArcGIS Pro - Connect and click Delete this
Add-In.

3. Click Yes. Make sure the add-in is no longer displayed.

Now that you’ve removed the older version, you can install a newer version of the add-in. 
Close the Add-In Manager and close ArcGIS Pro, then install the new version as described 
on page 1. 
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